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CINDEX Release Notes

Cindex 3.0 for Windows

This document explains how Cindex™ 3.0 for Windows differs from Cindex™2.0
for Windows.

You should read this document if you are upgrading from Cindex 2.0 for Win-
dows. You need not read this document if you are a new user of Cindex.

Overview of Major New Features

Unicode

Documents

Editing

Spelling Check

Cindex now uses Unicode to represent text, and can accommodate all languages
and scripts. Index entries can contain any characters that your computer can dis-
play, and Cindex can sort index entries by the collation rules appropriate to the
language in which you are working.

Windows and Mac versions of Cindex now use a common format for indexes,
index templates and stylesheets. Documents of these types can be freely inter-
changed between Mac and Windows computers.

New shortcuts provide for incrementing/decrementing page references, and for
automatically completing page ranges.

A new shortcut provides for swapping acronyms and their expanded phrases.

You can now VCI‘ify Cl'OSS-l‘CfCl‘Cl’lCCS asyou type them.

Cindex employs a new spell-checker. Dictionaries for many languages are avail-
able at no cost. User dictionaries can be of unlimited size. You can edit them




Import and Export

Macros

Sorting Entries

Patterns

System Requirements

Compatibility

freely as text documents: you can add, change or delete words, and you can paste
text from other documents.

A new import/export option provides for saving index records to, and reading
index records from, XML documents.

Cindex can import records in the tab-delimited format used by Sky Index 7 and
the comma-delimited quoted format used by Sky Index 6.

Cindex provides much richer capabilities for marking up formatted indexes as
tagged text documents. Full XML markup is now available.

Keystroke macros are now available when Cindex is running under Windows
Vista or Windows 7. Cindex no longer captures mouse clicks in Macros.

You can now choose among language-specific alphabetizing conventions. For
example, in a Swedish index, entries beginning with A are placed after entries

beginning with Z.

New options for both Word-by-Word and Letter-by-Letter alphabetizing sort
entries by the principles recommended by the Society of Biblical Literature.

Cindex provides new and much richer capabilities for finding and replacing text
represented by a pattern.

Cindex 3.0 works with Windows XP SP2 or higher. It will not run under any
earlier version of Windows.

With one exception, Cindex 3.0 can work with all documents made by earlier
versions of Cindex for Windows. Because Cindex 3 uses a new spelling checker,
it cannot use personal dictionaries compiled with Cindex 2.0.




When Cindex opens any version 2 document of the following kinds it makes a
new copy in version 3 format, and leaves the original untouched:

o Indexes (new filename extension .ucdx; interchangeable with Cindex 3 for Mac).

NOTE: In a version 3 index the following Reference Syntax settings 7zt be single
ASCII characters: Cross-Reference Separator; Page Reference Separator; Page Refer-
ence Connector. If the index being converted has used non-ASCII characters for any of
these settings, Cindex will change the character to the default value saved in preferences
(this is always an ASCII character), and will inform you about the change.

o Index templates (new filename extension .utpl; interchangeable with Cindex 3 for
Mac).

® Style sheets (new filename extension .ustl; interchangeable with Cindex 3 for Mac).

e Abbreviations (new filename extension .ucbr).

Document Management

Index documents

XML Records

Archives

Cindex now stores information about groups inside the index document. When
Cindex for Windows converts an old index to the new format, it retrieves infor-
mation about groups from any .cgp file associated with the index.

When an index has unsaved changes, its main window's title bar shows the index
name with an asterisk appended to it.

When you save a backup copy of the active index (Save Backup Copy... in the File
menu) Cindex sets the date/time stamp on the file to be the time at which the
copy was made (formerly the date/time stamp was the time at which the active
index was opened).

A new export/import option provides for saving index records to, and reading
index records from, XML documents (filename extension*.ixml). These docu-
ments can represent all Unicode characters and are the recommended format for
interchange with other indexing programs. imxl documents are in an open for-
mat accessible to any application program that can parse XML.

Archives (filename extension .arc) are the traditional backup and exchange for-
mat used by Cindex. Except for interchange with earlier versions of Cindex, this




Plain Text Records

Sky Index

format is not recommended because records in archives cannot represent all
Unicode characters. For interchange with other software, use the new XML
record format.

Cindex can import tab-delimited plain text records from documents with the
filename extension .txt (formerly .tab); when Cindex writes plain text records it
makes documents with the filename extension .txt (formerly .tab).

When Cindex imports tab-delimited records from a plain text document, it
checks whether the first characters in the file signify Unicode (UTF-8) encod-
ing. If Cindex finds the UTF-8 signature, it imports the text as Unicode; other-
wise it assumes that characters are encoded using the Windows ANSI character
set.

When Cindex imports plain text records, it places a \ before any of the charac-
ters that have special functions ({ } < > ~\) to ensure that they are treated as lit-
eral characters (e.g., { becomes \{ in the Cindex record).

When Cindex exports records as tab-delimited plain text, by default it uses Uni-
code (UTF-8) character encoding. You can change the encoding to the Win-
dows ANSI character set via Options... when the Save As... panel is displayed.
When writing records Cindex removes any \ or ~ used to indicate that the suc-
ceeding character is to be treated specially.

Cindex can import records in the tab-delimited format used by Sky Index 7
(*.sky7) or the comma-delimited quoted format used by Sky Index 6 (*.ext—
Cindex will detect this format by examining the contents of the document). As
Cindex imports records, it captures bold, italic, underline, subscript and super-
script styles, and translates any strikeout text style to small caps. Cindex also
translates the following attributes:

e Text to be ignored in sorting entries is enclosed in <...>.

e Text to used in sorting entries but to be hidden in a formatted display is enclosed in

e 'Note' text is enclosed in <{...}>.




Cindex DOS Data

Commands

New Commands

Commands Changed

Sky Index records may use up to three alternative fonts, but the document con-
tains no information about what these fonts are. If imported records use alterna-
tive fonts, Cindex assumes the Sky Index default assignments:

e Alternative Font 1: Symbol
e Alternative Font 2: Courier New

e Alternative Font 3: Times New Roman

Characters in Alternative Font 1 (Symbol) are converted to their Unicode equiv-
alents.

Cindex no longer exports records in this format, which has been deprecated
since Cindex 2. Cindex can still read records in this format.

There is one new command: Smart Flip Words... in the Document menu.

The set of words that Cindex uses for its 'Smart Flip' is now distinct from the list
that specifies prefixes to be ignored in sorting subheadings. Choose Smart Flip
Words... to edit the set of prefix/suffix words that Cindex should attend to when
executing a smart flip. When Cindex converts a version 2 index, it populates the
set with the words previously used by that index (the set of prefix words to be
ignored in sorting subheadings). For new indexes, Cindex provides a default set.
To edit this default set choose Smart Flip Words. .. when no index is open for
work.

Labeled (Edit menu). The menus displayed by the Labeled command (Edit menu
or contextual menus) now show the color associated with each label. The opera-
tion of the command is also changed: choosing a label now toggles the state of
that label. If you have records selected in the main window, Cindex applies or
removes the label according to the state of the first record in the selection: if the
chosen label matches the current label, that label is removed from all selected
records that carry that label. If the chosen label does not match the current label,
the chosen label is applied to all records in the selection. When you choose 'No
Label' Cindex removes all labels from the selected records.




Toolbars

Preferences

Symbols... (Character menu). The name of this command has been changed to
Character Map... to indicate that it can be used to insert any Unicode character in
arecord. (As before, many special characters can be entered in a record using the
keyboard shortcuts you use with MS Word.)

Abbreviations (Tools menu). This item now displays a submenu that contains all
the commands you use to manage abbreviation files.

To create a file to hold a new set of abbreviations, choose New... from the submenu
(formerly you opened Abbreviations with the New... command in the File menu).

To open a set of abbreviations, choose Load... from the submenu (formerly you
opened Abbreviations with the Open... command in the File menu).

To close the active set of abbreviations, choose Close from the submenu.

To edit abbreviations in the active set, choose Edit... from the submenu.

The record-entry window provides a new toolbar button to exchange the con-
tents of the leading text in a field with following text in parentheses (see “Acro-
nyms” on page 7.)

Several new settings are available when you chose Preferences. .. from the edit
menu:

Under the Editing tab check Complete Page Ranges to make Cindex generate the second
part of a page range automatically when you type the character that connects the two
parts of the range.

Under the Editing tab choose under Bad Cross-Ref whether Cindex should warn you if
enter in a record a cross-reference that has no target entry.

Under the View tab there is a new Entry View drop-down list used to set the size of text

displayed in the record-entry window. If you set 0 Cindex sets the size to match that
used for the main index view.




Adding and Editing Records

Page References

Acronyms

Pasting and Dropping
Text

Spelling

Two new capabilities make it easier to enter and edit page numbers and ranges in
the locator field.

® A new keyboard shortcut allows single-keystroke incrementing or decrementing of
page numbers. To increment the page number hit CTRL ]. To decrement the page
number hit CTRL [. This operation affects only the /ast component of the Jast page
reference in the locator field. If the last recognized component is not a number in
Arabic numerals (e.g., it consists of Roman numerals or is an alphabetic suffix), the
operation does nothing.

® A new Preferences setting “Complete Page Ranges” (under the Editing tab) config-
ures Cindex to generate the second part of a page range automatically when you type
the character that connects the two parts of the range. For example, if a dash is the
connecting character, and you entered 55- Cindex would complete the reference as
55-56. Cindex does this only if the /ast recognized component of the last page refer-
ence in the locator field is a number in Arabic numerals.

If a record field contains a phrase followed by text in parentheses (for example,
an acronym followed by its expansion, or vice-versa) you can exchange the con-
tents of the leading text with the text in parentheses by clicking a new toolbar
button or by hitting CTRL ALT S.

When you paste or drop text into the record window, Cindex now forces the size
of the new text to match the size used in the window.

Cindex employs a new spell-checker. Dictionaries for many languages are avail-
able at no cost. Cindex comes with a built-in dictionary for American English.

Cindex automatically deploys additional language dictionaries and supplemen-
tary special dictionaries, if these are located in specified places. For information
on obtaining and installing additional dictionaries, see the Cindex User’s Guide.

User dictionaries can be of unlimited size. You can edit them freely as text docu-
ments: you can add, change or delete words, and you can paste text from other
documents.




Sorting Entries

Formatting Entries

Cindex now follows language-specific alphabetizing conventions when sorting
entries. For example, in an index sorted by Swedish collation rules, Cindex
would place entries beginning with A after entries beginning with Z. Use the
new Llanguage drop-down list in the Sort... panel to choose the collation rules
Cindex will follow.

A new option, lgnore Parenthetical Phrases, allows full control of sorting text in
parentheses.

Cindex provides new preset options for sorting entries that make biblical refer-
ences. The Alphabetizing Rule drop-down list provides options for ordering entries
by the principles recommended by the Society of Biblical Literature (SBL).

There is a new setting for formatting cross-references (Cross-References. .. in the
Document menu). If you check Don't Apply Prefix Style if it Matches Existing Body
Style, Cindex will not apply an automatic style to the cross-reference prefix if that
style is already applied to the body of the cross-reference.

Cindex can now display headings for entries that are grouped generically under
numbers, or symbols, or numbers and symbols. The new settings are available
under Grouping Entries... in the Document menu.

When rendering SMALL CAPS on the screen or on a printer, Cindex now fully
emulates a small caps font: only lowercase letters are displayed or printed at
reduced size.

When rendering superscript or subscript text on the screen or printer, Cindex
now sizes and positions it better.




Exporting Formatted Entries

Export as Plain Text

Improved SGML Markup

Export as XML Text

Saving Tagged Text
Documents

When you save a formatted index as Plain Text, for maximum compatibility with
other application programs Cindex by default converts Unicode characters to
their counterparts in the Windows ANSI character set. This character set can-
not represent all Unicode characters, so the conversion may result in loss of
information. To ensure that all characters are encoded, you can export Plain Text
as Unicode (UTF-8). To specify the encoding choose Preferences... from the
Edit menu, then click the Export tab.

Cindex provides new options for specifying the structure of tagged text docu-
ments (Choose Markup Tags... from the Tools menu, then click the SGML tah).

e There is a new tag to identify an alphabetic group of entries.
¢ You can specify whether subheadings are nested hierarchically under headings.

®  You can specify whether the page reference tag or the cross-reference tag is applied to
each reference separately, or to the group of references in an entry.

®  You can specify how characters other than ASCII are to be represented in the tagged
text.

Note: When you open an old tag set Cindex automatically converts it to the new form.

You can save fully formatted indexes as XML documents. These are marked up
plain text documents in an open format, and can be interpreted by any applica-
tion program that can parse XML. Cindex provides a default set of XML tags,
and you can define additional ones.

Formerly, when you used Save As... (File menu) to export the contents of an
index, the list of available document types included all the tag sets you had
defined. In Version 3 Save As... shows only the currently selected XML tag type
and the currently selected SGML tag type. The currently selected tag sets are
those identified as the active tag sets on the XML and SGML tabs in the Markup
Tags... panel.




Checking Cross-References

Patterns

Cindex now more accurately verifies cross-references. When you choose Check
References. .. (‘Tools menu) and require an exact match when checking cross-ref-
erences, Cindex will explicitly flag references that match except for letter case or
accent.

With the use of Unicode to represent characters, Cindex provides new and much
richer capabilities for finding and replacing text represented by a patzern. For
example, you can now find any text that is in a particular script (e.g., Hebrew) or
any text that contains accented letters.

Patterns are now specified using a standard syntax that differs in some respects
from the syntax formerly used. Some of the special characters used in patterns
have changed functions. Two changes are of particular note:

e Where you would formerly have used ? to represent any character, use a period . .

e  Where you would formerly have used { } to enclose a subpattern, use parentheses e.g.,

().

These and other changes to the syntax and use of patterns are fully described in
the User’s Guide and in on-line Help.

When you use Find or Replace (Edit menu) to search for text that matches a pat-
tern, you can deploy ready-made patterns via the contextual menu displayed
when you right-click the Find box.
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